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Introduction 
Modern American appellate practice involves a great deal of writing and little oral 
advocacy.  But this was not always the case.  American appellate courts initially operated 
in much the same way as their English counterparts, deciding cases based almost 
entirely on oral argument.  Early on, the United States Supreme Court allowed 
unlimited time to counsel to argue their case.  It was not until 1849 that the Supreme 
Court imposed a time limit on oral argument, promulgating a rule that year limiting oral 
argument to two hours per side.1

But even as American appellate courts began limiting the time permitted for oral 
arguments, written submissions were typically no more than a bare bones outline of 
legal points and authorities.  It was not until at least the middle of the 19th century that 
American appellate lawyers began filing documents that we would recognize today as an 
appellate brief.

  Today, a four-hour argument seems unimaginable in 
all but the most extraordinary of cases. 

2

So what drove this change in American appellate practice away from presenting cases 
orally towards a heavy reliance on written briefs?  It’s difficult to say.  After all, English 
and Australian appellate courts continued the tradition of relying primarily upon oral 
argument until very recently.  Writing in 1994, one author stated: 

 

To this day, in England practice before the Court of Appeal is oral, and the only 
written item is a short “notice of appeal” giving a one to two sentence description 
of a legal point to be asserted without revealing the legal argument to be made.   
The practice of written legal argument, which is such a major part of modern U.S. 
procedure, is in fact a nineteenth century American innovation in the common 
law.3

Whatever the motive for this “American innovation,” advances in technology helped 
make it possible.  New technology no doubt drove much of what was expected from 
appellate attorneys in terms of their written products—just as it does today. 

 

For example, at the same time that American lawyers were beginning to produce more 
polished and extensive appellate briefs, the typewriter was being refined by American 
inventors and American companies.  American inventors named Christopher Latham 
Sholes, Carlos Soule, and Carlos Glidden (a lawyer) were granted a patent for a typing 
machine in 1868.  They would later sell their patent to E. Remington and Sons (which 
                                                             
1 R. Kirkland Corzine, The Emergence of Written Appellate Briefs in the Nineteenth-Century United States, 38 
Am. J. Legal Hist. 482 (1994). 
2 Id. 
3 Id at 483. 
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became the Remington Arms Company).  And in 1873, Sholes invented the QWERTY 
keyboard we still use today on our computers.  Remington, IBM, and other American 
companies would soon dominate the office equipment business. 

Not only did an American lawyer have a hand in inventing the typewriter, but an 
American lawyer also invented another piece of office equipment essential to the legal 
profession today: the photocopier.  Chester Carlson, the inventor of photocopying, was a 
patent attorney at the patent office in New York.  Because he was arthritic, he found the 
process of copying documents painful, which motivated him to conduct experiments 
with “electrophotography” in his kitchen.  He applied for a patent for this process in 
1938.  Carlson later had a hand in renaming the process “xerography” (derived from the 
Greek words for “dry writing”) and Xerox Corporation would sell the first xerographic 
machine in 1949. 

Within twenty years, the federal appellate courts embraced photocopies in lieu of 
directly typed or typeset briefs.  In 1967, the Advisory Committee changed Federal Rule 
of Appellate Procedure 32 to expressly permit them.4    Eventually, the Advisory 
Committee removed all references to carbon copies from Rule 32 “because the use of 
carbon paper is now very rare.”5   And the Advisory Committee noted that “[t]oday few 
briefs are produced by commercial printers or by typewriters,” to explain the need for 
rules regarding computer fonts.6

Now, all of the federal appellate courts have electronic filing.  And many state appellate 
courts have implemented electronic filing or plan to implement electronic filing in the 
near future.  The most recent estimate is that electronic filing will be available in the 
Supreme Court of Texas and the two Houston courts of appeals in October 2010—with 
deployment to other Texas appellate courts soon thereafter.   

 

Some advocates have pushed the limits of these new technologies to give their clients an 
edge. Consider a few examples from the Supreme Court of Texas.   In 1888, an attorney 
for Walgreen’s filed a typeset, bound brief printed on high quality paper along with a 
professional photographer’s photograph of the Walgreen’s store at issue, while 
Walgreen’s opponent filed a brief typed on thin onion skin paper.  In more recent times, 
Pam Baron inserted a photocopied image of a trial court’s erroneous postcard notice 
into her application for writ of error to catch the Court’s eye.7

                                                             
4 Fed. R. App. P. 32, Advisory Committee Notes on Rules—1967 Amendments. 

  In Timpte Industries v. 
Gish, a products-liability case, Timpte’s attorney Gary Bellair inserted color 
photographs of the grain-hopper trailer at issue to clarify the Court’s understanding of 

5 Fed. R. App. P. 32, Advisory Committee Notes on Rules—1998 Amendments. 
6 Id. 
7 Cause No. 95-0405, Stokes v. Aberdeen, Application for Writ of Error filed 6-5-1995 (copy available upon 
request to Clerk, Supreme Court of Texas). 
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his arguments.8  And in Whirlpool v. Camacho, attorney Lynne Liberato filed  a CD-
ROM brief with hyperlinks to the record and legal authorities, including an interactive, 
animated diagram illustrating the different parts of Whirlpool’s allegedly defective 
dryer.9

There may even be reason to think that these efforts have helped the Court complete its 
work more quickly.  In the Timpte case, the Court issued its opinion just three months 
after oral argument.  In the Whirpool case the Court issued its opinion just nine months 
after oral argument. 

  In each of these examples, the attorneys that used technology to better present 
their case prevailed.   

Where do we go from here?  The adoption of electronic filing opens up new ways for 
attorneys to prepare more effective briefs.  Some attorneys are already submitting 
electronic briefs containing hyperlinks to the record and legal sources, as well as 
photographic evidence.  No doubt, creative attorneys will push the limits of this 
technology to better advance a particular argument.  Their innovations may set the 
standard for the briefs of tomorrow. 

 

 

                                                             
8 Cause No. 08-0043, Timpte Indus., Inc. v. Gish, Petition for Review filed 3-17-2008 
(http://www.supreme.courts.state.tx.us/ebriefs/08/08004301.pdf).    
9 Cause No. 08-0175, Whirlpool Corp. v. Camacho, Petition for Review filed 4-3-2008 
(http://www.supreme.courts.state.tx.us/ebriefs/08/08017501.pdf).  

http://www.supreme.courts.state.tx.us/ebriefs/08/08004301.pdf�
http://www.supreme.courts.state.tx.us/ebriefs/08/08017501.pdf�
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Creating Better Electronic Briefs:  Practical Advice and Tips 

1. Buy Adobe Acrobat or another PDF conversion and editing software program. 
 
The simplest piece of advice for creating better electronic briefs is to purchase, and learn 
a few techniques for using, a full version of Adobe Acrobat.  That software converts 
documents into the PDF format, combines files together into one PDF document, 
creates bookmarks in PDFs, and performs a variety of other tasks useful in creating 
better electronic briefs.   

Adobe Acrobat comes in three different versions: Adobe Acrobat Standard, Adobe 
Acrobat Pro, and Adobe Acrobat Pro Extended.  Many attorneys will find that Acrobat 
Standard fulfills their needs.  One significant tool added in Acrobat Pro is the ability to 
redact PDF documents in electronic form—an important feature when your appendix or 
brief contains information such as social security numbers, drivers’ license numbers, 
minors’ names, and other sensitive data that should be or must be removed.  The 
redaction features of Acrobat Pro are fast, easy to use, and effective.  But if you don’t 
foresee yourself redacting documents, then buy Adobe Standard.   

This software is not cheap.  The list prices for these programs on Adobe’s website are: 
Adobe Acrobat Standard 9 ($299); Adobe Acrobat Pro 9 ($449); and Adobe Acrobat Pro 
Extended 9 ($699).  Some retailers offer the software for less.  For a complete list of the 
features offered in the different versions of these programs, please refer to the appendix 
where you will find a copy of Adobe’s online side-by-side comparison of the different 
versions (which was created by using Adobe Acrobat to convert Adobe’s web page into a 
PDF).  Adobe also offers a free trial version at http://www.adobe.com/products/. 

If you have an older version of Adobe Acrobat (like version 6 or 7) you can upgrade to 
the latest version for less than the full price.  Even if you are happy with the version you 
are using, you should consider upgrading to the latest version in order to get the latest 
security patches from Adobe.  Files you receive from other people—especially people you 
don’t know—may contain malicious code that can take over your machine, steal your 
passwords and client data, and otherwise make your life miserable.  Always remember 
to practice safe computing—especially with strangers. 

If the cost of Adobe Acrobat is too steep or you don’t like Adobe, there are other 
programs that perform many of the same functions as Adobe Acrobat.  Although Adobe 
created the PDF format, it is an open standard recognized by the International 
Standards Organization (“ISO”) as ISO 320000 – 1:20008.  Because it is an open 
standard, several software applications are available to convert documents into the PDF 
format—and many of them cost less than Adobe Acrobat.  Some of the available 

http://www.adobe.com/products/�
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alternatives, in no particular order, are Sonic PDF Creator ($74.95), PDF Converter Elite 
($99.95), PDF Converter 6 ($99.99) by Nuance, 1-2-3 PDF Converter ($59.90), 
NitroPDF Professional ($99.99), CutePDF Professional ($49.95), PDFtypewriter 
($29.99), PdfEdit995 ($19.95) and the free programs pdfforge,  cutepdf, and Pdf995 
(free version).  Additionally, Adobe can perform the conversion for you on the 
company’s website and so can Neevia.   

Before purchasing any PDF conversion software, it is highly recommended that you read 
more about the program’s features and that you try out a free downloadable version 
when possible.  While there are many programs that will convert documents into PDF, 
one must remember that the Supreme Court of Texas requires the appendix to be text 
searchable.  Adobe Acrobat will create searchable files from scanned documents using 
optical character recognition (OCR)—but alternative programs may not provide this 
feature or it may not be of the same quality. 

Whatever your personal choice, Adobe Acrobat remains the most written about, blogged 
about, and discussed PDF conversion and editing software.  In fact, Adobe sponsors a 
blog specifically for legal professionals called Acrobat for Legal Professionals.  This blog 
is essential reading for any attorney or legal professional that is interested in how to 
create better electronic briefs.  The blog links to videos and step-by-step instructions for 
all of the tips discussed below—so if the instructions below are not clear enough, or if 
you want to learn more about Adobe Acrobat, be sure to visit the blog. For a list of other 
useful blogs, books, and other resources, please see the list of resources  for creating 
better electronic briefs at the end of this article. 

For those reasons, most of the step-by-step instructions in this paper focus on how to 
use Adobe Acrobat in Microsoft Windows.  And where the instructions discuss Word 
and WordPerfect, the instructions were written using Word 2007 and WordPerfect X3.  

2. Combine Appendix Materials Together With the Petition or Brief. 
 

For almost ten years, the Supreme Court of Texas Clerk’s Office has requested electronic 
courtesy copies of briefs, which are posted online for the convenience of attorneys, the 
public, and the Court.  Initially, the Clerk’s Office only requested electronic courtesy 
copies when the Court requested briefs on the merits.  Once the Court requested briefs 
on the merits, attorneys were asked to submit copies of all the principal briefs filed in 
the case, including the petitions for review, the response, and the reply. 

Until recently, the Court provided few standards or guidelines for creating an electronic 
copy.  Many attorneys simply scanned their briefs in order to create electronic copies in 
compliance with the Court’s request, and these scanned copies were often not text-
searchable.  This scanning also created large files that, due to file-size limitations, often 

http://www.investintech.com/products/sonic/prod_sonic.htm�
http://www.pdfconverter.com/�
http://www.nuance.com/imaging/products/pdfconverter.asp�
http://www.123pdfconverter.com/�
http://www.primopdf.com/index.aspx�
http://www.cutepdf.com/Products/CutePDF/Pro.asp�
http://www.ctdeveloping.com/ctdeveloping/default.asp�
http://www.pdf995.com/�
http://www.pdfforge.org/�
http://www.cutepdf.com/�
http://www.pdf995.com/�
http://convert.neevia.com/�
http://blogs.adobe.com/acrolaw/�
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required appendix items to be broken into a separate file.  This became the accepted way 
of providing the Court with an electronic copy of the appendix. 

But on December 15, 2009, the Court issued an Order Requiring Electronic Documents 
in the Supreme Court.10

The thought was that attorneys would eventually have to electronically file documents 
and the appendices as a single unitary document (as opposed, e.g., to an electronic 
petition and a separate electronic appendix).  And the intent of the order was to help 
attorneys adjust to this new way of creating electronic briefs. 

  This new order mandated that electronic copies of petitions and 
briefs be created by converting these documents directly into a PDF rather than 
scanning them.  Recognizing that some appendix materials are not available in 
electronic form, the order allows appendix materials to be scanned—but discourages the 
use of scanners to create PDFs.  But however the PDF files are created, they must be 
searchable—including the appendix. 

Nevertheless, many attorneys continue to submit an electronic copy of the petition or 
brief along with a separate electronic copy of the appendix.  If one takes advantage of 
Adobe Acrobat’s ability to convert just about any document directly into a searchable 
PDF and to combine PDF files together, submitting a separate appendix should rarely be 
necessary or desirable.  Having one document that contains the petition or brief and any 
appendix is more convenient for the reader.  

What’s more, it’s easy to combine PDF files together using Adobe Acrobat or another 
similar program.  In Adobe Acrobat follow these simple steps:  

1. Open Adobe Acrobat. 
2. Click on the Combine menu in the main ribbon. 
3. Choose Merge Files into a Single PDF. 
4. Drag and drop files into the dialog box. 
5. Once all of your files have been dropped into the dialog box, put the 

documents in the order you would like for them to appear in the combined 
file.  You can move documents up and down in the dialog box and by clicking 
on them and then choosing the Move Up or Move Down arrows in the dialog 
box. 

6. Click Combine Files in the lower right hand corner of the dialog box. 
7. Give your new document a name and click Save. 

                                                             
10 The Court then amended this order on May 4, 2010. 

http://www.supreme.courts.state.tx.us/miscdocket/10/10906500.PDF�
http://www.supreme.courts.state.tx.us/miscdocket/10/10906500.PDF�
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You can also combine files together without opening your copy of Adobe Acrobat.  
Simply select all the files you want to combine together, right click, and choose Combine 
Supported Files in Adobe Acrobat.   

Regardless of which of these methods you use, you do not have to convert the 
documents into PDF before combining the files together—so long as Adobe Acrobat is 
capable of converting the files into PDF.  Adobe Acrobat will both convert the files and 
combine them together in one process. 

You can watch a video demonstration about of how to combine PDF files together on the 
Adobe Acrobat for Legal Professionals blog. 

3. Whenever Possible, Convert Documents Directly to PDF Instead of Scanning. 
 

Unfortunately it is not yet possible to obtain all the required contents of an appendix in 
a native electronic format.  Perhaps someday all Texas trial courts will have electronic 
filing and will issue orders electronically.  Until then, trial court judgments, orders, jury 
charges and verdicts will have to be scanned in order to create an electronic appendix. 

But many attorneys are still printing out documents that they have in electronic format 
and scanning them in order to create the electronic copy of the appendix.  For example, 
many attorneys print out and scan the court of appeals’ opinion rather than converting 
it directly to a PDF.  And many statutes, regulations, and rules that are available in 
electronic format are printed and scanned.  A better practice is to do this conversion 
directly from one electronic format to another using Adobe’s tools.  This will help reduce 

https://admin.adobe.acrobat.com/_a295153/p81291074/�
http://blogs.adobe.com/acrolaw/�
http://blogs.adobe.com/acrolaw/�
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the size of your files (making them easier to transmit, download, and store) and make 
them easier to read because the images are sharper and clearer. 

How does one convert a document directly to PDF?  The answer depends on whether 
you are using Word, WordPerfect, or Adobe Acrobat (or similar software).  Rather than 
reinventing the wheel and create a new set of instructions, we have included the step-by-
step instructions for converting documents into PDF posted on the United States Court 
of Appeals for the Fifth Circuit’s website.  This set of instructions (which was originally 
developed by the Fourth Circuit) is included in this paper’s appendix.  

4. Use Bookmarks 
 

What’s a bookmark?  PDF bookmarks 
appear on the left side of the Adobe Reader 
window (pressing F4 will toggle the visibility 
of the Bookmark panel).  PDF bookmarks 
act like a hyperlink allowing one to jump 
immediately to other sections of the 
document that have been bookmarked.  By 
creating bookmarks, one essentially creates 
clickable table of contents or index for a 
brief.  But unlike a table of contents or 
index, the list of bookmarks does not 
disappear once you turn the page; the 
bookmark panel is always within view (until 
you decide to hide it). 

Bookmarks are such a useful tool for creating more easily navigable electronic 
documents that the Texas Supreme Court’s Amended Order Requiring Electronic 
Documents encourages attorneys to use them.11     Bookmarks are particularly useful in 
helping Justices and their staff find appendix materials that are attached to a petition or 
brief.12

Adobe Acrobat will generate bookmarks automatically during PDF creation from the 
table-of-contents entries of a document created by most desktop publishing programs 
like Word.  But how you do the conversion matters.  In Word 2003 and 2007, using the 

 And revisions to the Uniform Format Manual for Court Reporters will require 
the use of bookmarks to make court reporters’ records easier to use. 

                                                             
11 Misc. Docket No. 10-9065, Amended Order Requiring Electronic Documents in the Supreme Court, 
paragraph 3. 
12 Id. (“The use of bookmarks to assist in locating appendix materials is encouraged”). 

http://www.ca5.uscourts.gov/cmecf/ConvertWordProcessedDocsToPDF.pdf�
http://www.ca5.uscourts.gov/cmecf/ConvertWordProcessedDocsToPDF.pdf�
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Acrobat PDFMaker13

One advantage of using paragraph styles in Word is that each time you update the Word 
document and convert it to PDF, the bookmarks created by Adobe Acrobat will be 
updated.  Adobe will also use these styles to properly nest the bookmarks into an outline 
form. 

 tool will also generate bookmarks automatically, but merely saving 
the file as a PDF from within Word does not.  In any event, to generate bookmarks 
automatically using Word, you must use paragraph styles (e.g. Heading 1, Heading 2).  A 
tutorial on Word’s paragraph styles is beyond the scope of this paper, but it would be 
worth your time to learn to set them.  (Your staff may have already defined the 
formatting details for each style as part of a brief template file that you are using.)  

If Adobe does not automatically generate them, it is easy enough to manually create 
individual bookmarks in Adobe Acrobat.  Follow these steps to create a bookmark in 
Adobe Acrobat 9: 

1. Click on the page where you want to create a bookmark.  Make sure the Single 
Page button on the toolbar is selected; a bookmark will display a page at the 
magnification that was used when the bookmark was created. 

2. In the Bookmarks panel, click the New Bookmark icon.  Or press the CTRL 
and B keys simultaneously. 

3. In the text box of the new bookmark, type the name or label that you want to 
give to the bookmark (e.g. Appendix A-Summary Judgment Order).  If you are 
bookmarking an argument heading, a shortcut is to highlight the text of that 
argument heading before hitting Control-B.  Adobe will then use that text for 
the bookmark name. 

4. If you need to rearrange the order of your bookmarks, drag the bookmark into 
the correct location in the bookmark hierarchy and release the bookmark 
when you see the arrow and dotted line where you want the new bookmark to 
appear. 

5. Choose File > Save to save your work. 
6. Test your bookmark to make sure it works.     

If you inadvertently put your bookmark in the wrong place, you can delete the bookmark 
and repeat the steps above.  Or you can change the bookmark’s destination by following 
these steps: 

                                                             
13“ When you install Acrobat, the install utility searches your machine for Microsoft Office applications.  When 
a supported Microsoft Office applications is found, Acrobat installs Acrobat PDFMaker as a helpful utility.  
With Acrobat PDFMaker, you can create a PDF that looks identical to the Microsoft Office file by clicking a 
Convert to Adobe PDF icon which is added to your Microsoft Office 2003 application.  If you own a Microsoft 
Office 2007 application, Acrobat creates an Acrobat Ribbon with icons to convert files to PDF.”  Doug Sahlin, 
How to Do Everything: Adobe Acrobat 9 (McGraw-Hill 2009). 
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1. In the Bookmarks panel, click the icon for the bookmark whose destination 
you want to change.  The document pane will display the page the selected 
page. 

2. Click the Next Page button or Previous Page button on the toolbar as many 
times as necessary to go to the desired page of the document (i.e. the page you 
want the bookmark to link to). 

3. Click the Options button at the top of the Bookmarks panel and choose Set 
Bookmark Destination from the menu.  Click Yes in the confirmation message 
to update the bookmark’s destination. 

4. Choose File > Save to save your work. 

 
Be sure to give your bookmarks names that will be useful to a reader.  Using names like 
Appendix A, Appendix B, etc. is not particularly helpful (although better than nothing).  
Instead, try something like Appendix A—Summary Judgment Order, Appendix B—
Court of Appeals’ Opinion, etc. 
 
Click here to watch a free online tutorial on creating bookmarks in Adobe Acrobat. 
 

5. Set the initial view of your PDF to show the bookmarks you created. 
 
Once you have created bookmarks, you will want to be sure that the reader knows that 
there are bookmarks available to help navigate through the document.  In Adobe 
Acrobat, you can set the Initial View options for the document so that the Bookmarks 
Panel displays automatically when the document is opened.14

 

  To set the Initial View 
options to display the bookmarks, follow these steps: 

1. Choose File > Document Properties. 
2. Click on the Initial View tab at the top. 
3. In the Document Options section choose Bookmarks Panel and Page from the 

Navigation tab list. 
4. Click OK. 

                                                             
14 Setting the Initial View to show bookmarks works the same way in Apple’s “Preview” PDF viewer.  When 
you open the PDF, the bookmarks appear as a list in the sidebar. 

http://www.sokolconsulting.com/swf/abt_bkmks/index.htm�
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Notice too that you can set other Initial View options: you can set the document to open 
at a particular zoom and on a given page.  For an appellate brief, you probably do not 
want to change the default settings. 
 

 6.  Create hyperlinks to internet resources. 
 
Creating hyperlinks to cases or other resources relied upon in your brief can be of great 
convenience to the Justices and their staff.  Instead of having to look the materials up 
themselves, you can provide the cited source to them with a click of the mouse.  The 
steps for creating hyperlinks vary slightly depending on whether you are creating the 
hyperlink in Word, WordPerfect, or Adobe Acrobat.   
 
When creating hyperlinks to resources on the web, remember that these resources may 
not be permanently located at the internet address you are using to create the 
hyperlink—so you may want to consider saving the legal resource as a PDF document 
and including it with your appendix.  Adobe Acrobat should have installed a PDFMaker 
utility into your web browser to allow you to easily convert a web page into a PDF.  You 
can then use Adobe Acrobat to create a hyperlink to the PDF document in your appendix 
from the text of your brief (see the instructions below).  Of course as long as there are 
paper filing requirements you will have to include a copy in your paper filing. 
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You should also keep in mind the rules for citing internet resources, which require the 
inclusion of the URL in the citation.  But URLs are often such eyesores that you might 
consider putting the URL in a footnote and creating a hyperlink from the text in the 
body of the brief. 
 

To create a hyperlink in Word 2007: 
 

1. Left click and highlight the text in your brief where you want to create the 
hyperlink (e.g. if you want to create a hyperlink from a case citation, left click 
and highlight the case citation). 

2. Once the text is highlighted, place your cursor over the highlighted text. 
3. Right click on the highlighted text. 
4. Select Hyperlink.  
5. The Insert Hyperlink dialog box appears. 
6. Copy and paste or type the web address into the space labeled Address and 

then click OKAY. 
 
OR: 
 
1. Left click and highlight the text in your brief where you want to create the 

hyperlink. 
2. Choose Insert from the menu bar and click Hyperlink to bring up the 

Insert Hyperlink dialog box. 
3. Copy and paste or type the web address into the space labeled Address and 

then click OKAY. 
 
When you use Adobe Acrobat to convert the Word document to a PDF, your hyperlinks 
will be preserved.  But always be sure to check hyperlinks to make sure they are 
working. 
 

To create a hyperlink in WordPerfect X3: 
 

1. Left click and highlight the text in your brief where you want to create the 
hyperlink (e.g. if you want to create a hyperlink from a case citation, left click 
and highlight the case citation). 

2. Select Tools in the toolbar menu. 
3. Select Hyperlink.  The “Create a Hyperlink” dialog box will open. 
4. Add a hyperlink to a website by typing in the full website address in the 

“Document/Macro” text box.  Select OK.  Or select “Browse Web…” to launch 
your internet browser, navigate to the web page you want to hyperlink to, and 
then copy and paste the website address into the “Document/Macro” textbox.  
Select OK. 
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If you use hyperlinks in WordPerfect documents, be sure to read the U.S Court of 
Appeals for the Fifth Circuit’s instructions on how to publish your WordPerfect 
document to PDF (as opposed to printing to PDF).  Publishing the document to PDF will 
preserve your hyperlinks.  But printing the document to PDF will not preserve your 
hyperlinks. 
 

To create a hyperlink in Adobe Acrobat: 
 

1. Select the text or graphic element, such as a photo, with the Select tool (the 
arrow in the toolbar). 

2. Right click (Windows) or CTRL-click (Apple), and then choose Create Link 
from the menu.  The Create Link dialog box appears. 

3. In the Link Appearance area of the Create Link dialog box, click on the Link 
Type drop-down arrow and choose one of the following: (1) Visible Rectangle 
(creates a link with a visible rectangle); (2) Invisible Rectangle (creates a link 
that isn’t visible). 

4. If you choose to make your hyperlink visible, click on the Line Thickness 
drop-down arrow and choose, Thin, Medium, or Thick.  This option defines 
the thickness of the hyperlink border. 

5. Click the Line Style drop-down arrow and choose, Solid, Dashed, or 
Underline.  This option defines the style of the line indicating the presence of 
a hyperlink.  Most people choose Underline. 

6. Click the Color Swatch and choose the color of your line.  Most people choose 
a light blue. 

7. Choose one of the following of the following from the Link Action area to 
specify the action that is taken when the hyperlinked is clicked: 
 

• If you are creating link to a web page, choose “Open a Web Page”. 
The Edit URL dialog box appears, enabling you to enter URL of the 
web page that opens when the hyperlink is clicked.  
 

• If you are creating a link to a page in your PDF file (e.g. you 
combined your petition and appendix together as one file and you 
want to add a hyperlink in your petition to a page in your 
appendix), choose “Go to a Page View”.  This allows you to specify 
which page will appear and at what zoom level when the hyperlink 
is clicked. 
 

• If you are creating a CD containing your brief and the materials 
cited in your brief, choose “Open a File.”  This will load the file 
when the hyperlink is clicked.  The files you are linking to must be 
on the same CD as the brief and the file paths must remain the 
same. 
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7. Use Pictures to Illustrate Your Point 
 

In the right case, a picture can be worth a thousand words.  For example, in Timpte 
Industries, Inc. v. Gish a worker sued the manufacturer of a grain-hopper trailer 
alleging the trailer was defectively designed after a sudden gust of wind blew him off of 
the trailer.  The trial court rendered a take-nothing summary judgment under Rule 166a 
after Timpte challenged the existence of evidence supporting Gish’s defective-design 
product-liability claim.  But the appellate court reversed and remanded on the grounds 
that there was “some evidence upon which reasonable factfinders could disagree as to 
whether the trailer’s design was both unreasonably dangerous and a cause of Gish’s fall.”  
At the Supreme Court of Texas, Timpte inserted color photographs into its petition for 
review illustrating the different components of the trailer that were allegedly defective.  
The Supreme of Texas granted review and reversed and rendered a judgment in favor of 
Timpte.  The Court issued the opinion in less than three months from the date of oral 
argument. 

Gary Bellair, the attorney for Timpte, agrees that in this case pictures were worth a 
thousand words.  According to Mr. Bellair, describing the design of the grain-hopper 
trailer using just words would not have been as clear as using pictures. 

In Whirlpool Corporation v. Camacho a jury determined that a Whirlpool 
manufactured electric clothes dryer caused a fire that resulted in the death of the 
plaintiffs’ son, Joab Camacho.  The jury awarded the Camachos $14 million in actual 
damages.  The court of appeals affirmed the verdict.  At the Supreme Court of Texas, 
Whirpool submitted a hyperlinked petition for review on a CD containing all the record 
and the legal authorities.15  The petition also used many of the techniques discussed 
above for creating better electronic briefs, including extensive use of bookmarks and 
setting the initial view of the document to show the bookmarks.  The CD also included 
an Adobe Flash interactive diagram of Whirlpool’s dryer.  The interactive diagram 
illustrated the different parts of the dryer and the air-flow through the dryer.16

opinion

  The 
Supreme Court of Texas granted review and reversed and rendered judgment in favor of 
Whirlpool.  The Court issued the opinion nine months after it heard oral argument.  The 

 included a diagram of the relevant parts of the dryer taken from the CD. 

Lynne Liberato, the attorney for Whirlpool at the Supreme Court of Texas, says that she 
thinks the interactive diagram of the dryer was particularly helpful in explaining to the 
Court how the dryer worked.  And she thinks that the cost of preparing hyperlinked 
appellate briefs, such as the one she filed in the Whirlpool case, will continue to 

                                                             
15 The links in the petition posted online do not work.  The links are to the materials contained on the CD—
not to internet resources or documents contained within a combined PDF file. 
16 The electronic brief was created by ThemeVision, LLC (www.themevision.com).  

http://stmarytxlaw.mediasite.com/mediasite/SilverlightPlayer/Default.aspx?peid=6e6fc5e37c444aafb3e3941aedbba288�
http://stmarytxlaw.mediasite.com/mediasite/SilverlightPlayer/Default.aspx?peid=6e6fc5e37c444aafb3e3941aedbba288�
http://www.supreme.courts.state.tx.us/ebriefs/08/08004301.pdf�
http://www.supreme.courts.state.tx.us/opinions/HTMLOpinionInfo.asp?OpinionID=2001400�
http://stmarytxlaw.mediasite.com/mediasite/SilverlightPlayer/Default.aspx?peid=a6315b73d2d74cf88925d1c6d34be398�
http://www.supreme.courts.state.tx.us/ebriefs/08/08017501.pdf�
http://www.supreme.courts.state.tx.us/opinions/HTMLOpinionInfo.asp?OpinionID=2001496�
http://www.themevision.com/�
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decline—making them much more common, if not standard practice, in appellate cases 
in the future. 

Of course pictures and videos are not helpful in every case.  But in products liability 
cases like Timpte and Whirlpool, pictures and videos may be particularly effective in 
illustrating the design and function of the products at issue.  Real estate cases involving 
disputes over metes and bounds might benefit from a map or diagram of the property.  
And many tort cases that depend upon a particular set of facts to prove or disprove 
liability may be particularly well-suited for the use of photos, videos, or other 
illustrations. 

Inserting pictures or photos into Word or WordPerfect documents is relatively easy to 
do.  And wrapping text around the pictures to give the brief a professional appearance is 
also easy to do. 

How to Insert a Picture in Word 2007: 
1. Click where you want to insert the picture. 
2. On the Insert tab, in the Illustrations group, click 

Picture.  
3. Locate the picture you want to insert. 
4. Double-click the picture you want to insert. 

How to Wrap Text Around a Picture in Word 2007: 
1.  Select the picture. 
2. Under the Picture Tools, on the Format tab, in the Arrange group, click 

Position. 

 

3.  Click on Text Wrapping and choose your preferred layout. 

OR: 

1.  Right click on the picture. 
2. Choose Text Wrapping and select your preferred layout. 
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How to Insert a Picture in WordPerfect X3: 
1. In WordPerfect X3, click where you want to insert the picture. 
2. Choose Insert > Graphics > From File. 
3. In the Insert Image dialog box, locate the picture you want to insert and 

click Insert. 
4. If necessary, you can adjust the size of the inserted picture by clicking to select 

the picture, and then dragging one of the corner handles. 

How to Wrap Text Around a Picture in WordPerfect X3: 

1. Right-click the image, then select Wrap from the menu. 
2. You can then select one of the following options in the Wrapping Type 

section: 

• Square wraps the text around the edges of the graphics box 
• Contour wraps the text around the outline of the image 
• Neither Side wraps the text above and below the image but leaves the 

space either side of the image blank 
• Behind Text places the image behind the text and runs the text over the 

image 
• In Front Of Text places the image on top of the text and runs the text 

behind the image 

If you choose square or contour then you will also need to select one of the 
following options in the Wrap Text Around section: 

• Largest Side wraps the text along the side of the image with the longest 
dimension 

• Left Side wraps the text along the left side of the image 
• Right Side wraps the text along the right side of the image 
• Both Sides wraps the text along both sides of the image 

3. Once you have made your selection click on the OK button to apply your wrap 
selections to the graphic. 

Creating Better Electronic Briefs:  Create Your Own Hyperlinked Electronic Brief 
 
If you have Adobe Acrobat or similar software and you can master the skills discussed 
above (combining PDF files, creating Bookmarks, and creating Links) you can create 
your own professional quality hyperlinked electronic brief that includes links and 
bookmarks to all of the sources cited in your brief—much like the commercial vendors 
that offer this service.  All you have to do is follow these steps: 
 

1. Write your brief. 
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2. Download the cases you cited from Westlaw or Lexis in electronic format. 
3. Get an electronic copy of the clerk’s record and/or the court reporter’s record. 
4. Combine these files into a single PDF. 
5. Create bookmarks as appropriate. 
6. Create hyperlinks to your citations using the steps discussed above. 

 
If all this sounds easier said than done, then watch a video from the Adobe Acrobat for 
Legal Professionals Blog about creating hyperlinked electronic briefs and see for 
yourself how easy it is. 
 
Of course you do not have to hyperlink all of your sources.  And you may not feel like 
creating that many hyperlinks.   
 
If you do want to include everything, but the file would be too big to e-mail, then 
consider putting all of the cases and record citations on a CD, along with your brief, and 
create hyperlinks to files as explained above.  Remember, if you move the files around 
on your CD after you have created the hyperlinks, you may break the hyperlinks.  Be 
sure to test everything out before you submit it. 
 
One important consideration is that the Supreme Court of Texas’ order regarding 
electronic copies also states “[e]lectronic copies must be substantively identical to the 
original filed with the Clerk of the Court.”  The way the rule is currently written, if you 
include all of the cited cases in your electronic copy, you will have to include them in 
your paper copy as well.  Therefore, you may want to just choose the most important 
cases and record citations to include in your hyperlinked brief in order to reduce the 
cost of creating a paper copy and the amount of work involved in creating hyperlinks.  
An alternative is to file a motion seeking permission to file an electronic brief that 
includes all the record and legal citations without the need to provide a paper appendix 
that includes all of these sources.17

 

  But you may want to get this permission before you 
start hyperlinking. 

If this all still overwhelming, but you are determined to submit a hyperlinked brief and 
have the resources to hire someone to turn your brief into a hyperlinked brief, check the 
list of companies included in the list of resources for creating better electronic briefs 
below.  One way to reduce the costs of preparing a hyperlinked CD containing the record 
and the legal citations is for the parties to share the costs of preparing the electronic 
briefs and to submit a single CD containing all the briefs.  That’s what Jennifer Tillison 
of Alexander Dubose & Townsend LLP did in an appeal to the Amarillo Court of 
Appeals, No. 07-07-00073-CV, Golden Spread Electric Cooperative, Inc. v. Denver City 
Energy Assocs., L.P.  All citations in all the briefs were hyperlinked to the appropriate 
place in the record or to the cited authority.  And the briefs were thoroughly 
bookmarked and internal hyperlinks were created (for example, from the brief’s table of 
contents to the appropriate page). 
 
                                                             
17 Whirlpool filed a similar motion in Whirlpool v. Camacho (Supreme Court of Texas, Cause No. 08-0175, 
Unopposed Motion to File Corresponding Petition for Review on Compact Disc, 4-28-2008).  The Court 
granted the motion the day after it was filed. 

https://admin.adobe.acrobat.com/_a295153/p72935018/�
http://blogs.adobe.com/acrolaw/�
http://blogs.adobe.com/acrolaw/�
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Best Practices for Using Hyperlinks in Electronic Briefs 
 

Ideally, every citation that appears in your brief should be complete enough for a 
researcher to follow — without clicking on your hyperlink.  With case law, the traditional 
citation is adequate.  For true internet sources, including a typed-out version of the URL 
seems essential.  In the middle ground, you have to use your judgment.  But, in general, 
you should not want to trap your reader into clicking the link.  It should be an option 
available to them — not the only way to reach the information. 

That will help you avoid these two problems: 

• Broken links.  The obvious fear is that the link will break if someone takes down or 
moves the webpage.  You should use some care in picking resources unlikely to 
change.  Where possible, use a good citation format plus a hyperlink; don’t put all your 
trust in the hyperlink.  
 
If you do not have a good citation to a readily available paper version, then by all 
means you should download and attach a PDF version of the webpage.   

 

• Pages that might change subtly.  The less obvious — but more serious — fear is that the 
cited resource will change between the time you write your brief and the end of your 
case.  Let’s say that you cite a webpage that contains the text of a statute.  Then the 
statute is amended, and the webpage owner changes its page to reflect the new 
version.  Now, when the Court follows your hyperlink, they come to the wrong 
information. 
 
The ultimate cure is for more websites (especially government websites) to adopt 
systems for showing the different versions of the same page.  Wikipedia gets a bad rap 
from the legal community for letting anyone make edits, but it has a phenomenal 
system for tracking changes that should be the envy of every legal website.  In short, 
you can grab a “permanent link” to the specific version of the Wikipedia page you’re 
citing to use as the URL.  When a reader follows that permanent link next month, they 
will always get the same page you see today — plus a small alert at the top if there is a 
newer version and a chance to view a redline of the differences in the two versions.   It 
means that you can safely cite to Wikipedia today in a way that you can’t cite to an 
online version of a statue or a rule. 
 
In the meantime, you should try only to hyperlink to things that don’t change.  For 
example, court opinions, past legislative history, briefs that have already been filed.  If 
you must cite something that is in flux, consider attaching a PDF version or using an 
online service that archives webpages. 
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If in doubt, don’t put an external hyperlink.  There is no requirement (yet) that you link 
to everything that your brief mentions; use some judgment and avoid the headaches of 
having these things break, change, or cause concern. 

 

Avoid Using URL Shorteners (For Now)  
 

One of the fears that court systems have of using hyperlinks is that the court’s activities 
will somehow be monitored.  URL shortener services present a special concern.  
 
URL shortener services take a long URL that might be difficult to wedge into a citation 
sentence without awkward formatting (such as 
http://www.supreme.courts.state.tx.us/historical/2010/may/080465.htm) and 
shortens it dramatically (like http://bit.ly/b2ZsrV).  There are many of these services, 
and they are very convenient. 
 
The typical URL shortener, however, tracks when people click on these shortened URLs 
and reports that back to the person who created the link.  Some, such as bit.ly, share 
that information with the world.  Just attach a + to the end of a bit.ly URL to see 
analytics: http://bit.ly/b2ZsrV+. 
 
For now, you should probably avoid these services for electronic briefs.  There is 
potentially great value in having a dedicated URL shortener for legal citations.  But until 
someone creates one with appropriate privacy assurances, these services create 
justifiable suspicion. 
 
The better practice is to use the full URL, no matter how ugly it may be (although you 
might want to consider inserting them into a footnote) 

 
 
 

http://www.supreme.courts.state.tx.us/historical/2010/may/080465.htm�
http://bit.ly/b2ZsrV�
http://bit.ly/b2ZsrV+�
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What the Future Might Hold for Appellate Briefs,  
and What You Can Do Now 

The recent past and the near future 
 
The early history of electronic briefs has been driven by at least three distinct groups.    
The challenge is how to create an electronic brief that can satisfy the needs of each of 
these constituencies. 

• Self-Expression of Attorneys and Clients.  The first phase of electronic briefing 
used CD-ROMs as a way for attorneys to make a particular point.  The first  CD-ROM 
was filed in the U.S. Supreme Court in 1995. An amicus filed the second in 1997 in the 
ACLU v. Reno case to help the Court see that the internet had many things beyond 
smut.18  The CD-ROM included “color pages of the amici Websites and a hyperlink 
function that allows the user to go online to link to current amici Web pages.”19  As 
simple as that sounds today, this early CD-ROM brief was making a point about the 
medium of the internet itself. 
 
As the idea moved into the lower courts, the briefs tended to be filed in large complex 
cases.  Eventually, some courts adopted rules expressly permitting litigants to file a 
CD-ROM brief with the Court.  A number of publishers help large firms prepare these 
CD-ROM e-Briefs, which remain expensive.  The CD-ROM briefs are still, 15 years 
later, filed as CD-ROMs, even though many reading devices (including smaller 
laptops) don’t have drives for that media.20

• Administrative Convenience of the Courts.  The second phase started at roughly 
the same time as the first, but has been driven by different concerns.  In 1995-1996, 
the Northern District of Ohio implemented an electronic filing system to handle its 
asbestos docket.

  As courts and the public now rely on 
electronic docket systems, CD-ROM electronic briefs remain trapped in the court’s 
physical filing cabinets rather than a form that can be uploaded to the internet. 

21  This grew into the federal CM/ECF system.22

                                                             
18 A more contemporaneous account is available in the piece Electronic Briefs in Trial and Appellate Courts by 
Bradley J. Hillis, available at 

 

http://jurist.law.pitt.edu/courttech3.htm (dated April 20, 2000). 
19 Press Release, “ACLU Sends Supreme Court Passionate Defense Of Free Speech in Cyberspace”, available at 
http://www.aclu.org/technology-and-liberty/aclu-sends-supreme-court-passionate-defense-free-speech-
cyberspace (dated Feb. 20, 1997). 
20 If this trend continues, then the vendors may shift to USB sticks.  But these USB sticks would still have the 
other limitations and advantages as CD-ROMs. 
21 Press Release, “Technology Increases Public Access to Federal Courts” (Jul. 24, 1996), available at 
http://www.uscourts.gov/News/NewsView/96-07-
24/Technology_Increases_Public_Access_to_Federal_Courts.aspx. 

http://jurist.law.pitt.edu/courttech3.htm�
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http://www.uscourts.gov/News/NewsView/96-07-24/Technology_Increases_Public_Access_to_Federal_Courts.aspx�
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As clerk’s offices have shifted toward requiring electronic filing of briefs as PDFs, they 
reduced the hassle of dealing with physical briefs.  Court staff can now readily consult 
PDF copies instead of visiting a central filing system.  Members of the public can 
consult those PDFs, as well, reducing inconvenience to court staff while creating a 
lucrative profit center (at least for the federal CM/ECF system, which makes hundreds 
of millions of dollars per year selling PDFs by the page). 
 
But because the focus was simply on corralling paper, these systems did not generally 
require the PDFs being filed to be word-searchable.  The focus was on the files — 
receiving briefs, putting them into a predictable location in the system, and letting 
people retrieve them.  The federal CM/ECF goal was fidelity to paper, not improving 
upon it.  

 

• The Consumers of Briefs: Judges and Law Clerks.   In the third phase, the 
ultimate consumers of appellate briefs are starting to influence how electronic briefs 
are made, based on their own knowledge of how these briefs fit into the decision 
process of the court.  Ideally, electronic briefing should make the job of the court 
easier.  As judges change how they use electronic briefs, their preferences will start to 
drive briefing requirements.  And as litigants demonstrate that a particular technique 
can be helpful, judges can start to encourage that sort of filing by others.  
 
A related but very significant change is in how judges read electronic documents.  
While the federal CM/ECF documents were well suited to be printed onto paper, an 
increasing number of judges now consume PDF briefs natively on a screen — whether 
a laptop, a desktop, or a portable e-reader.  A judge may also want to work at home 
using files from the Court’s server, rather than being limited to the court’s physical 
files.  The result is a premium placed on the ability to remotely access the electronic 
version — making a simpler PDF potentially more useful than a richer CD-ROM. 

 

Online Sources: The Billion-Dollar Question 
 
To really use a legal brief, the reader must be able to shift focus from the brief text to 
various pages from the appellate record, to other briefs filed in the same case, and to 
precedents from other courts, and to legislative materials. 

You can think of legal citations as hyperlinks that expect the reader to do the work.  
When the cite says “123 S.W.3d 456,” that is a recipe for the reader to go to a particular 
shelf, grab a particular volume, and turn to a particular page.  Even electronic sources 
(such as Westlaw or Lexis) may save walking down the hall, but they still place some 
                                                                                                                                                                                                    
22  Wikipedia, “CM/ECF,” available at http://en.wikipedia.org/w/index.php?title=CM/ECF&oldid=332380514 
(visited May 24, 2010); see also Press Release, “Electronic Case Filing in Federal Courts Reaches Milestone” 
(Nov. 21, 2005) available at http://www.uscourts.gov/News/NewsView/05-11-
21/Electronic_Case_Filing_in_Federal_Courts_Reaches_Milestone.aspx. 

http://en.wikipedia.org/w/index.php?title=CM/ECF&oldid=332380514�
http://www.uscourts.gov/News/NewsView/05-11-21/Electronic_Case_Filing_in_Federal_Courts_Reaches_Milestone.aspx�
http://www.uscourts.gov/News/NewsView/05-11-21/Electronic_Case_Filing_in_Federal_Courts_Reaches_Milestone.aspx�
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degree of burden on the reader to open a browser, log into the service, and type the 
citation into a form. 

Electronic hyperlinks, however, shift this work to the computer (and to the brief 
author).  By connecting the reader directly to the raw legal authority, a hyperlinked brief 
can save the reader significant effort — and make it easier for them to evaluate the 
merits of the brief. 

Unfortunately, due to publishing restrictions, it is hard to create electronic hyperlinks to 
online sources of legal authority.  Many primary legal materials are only available 
through commercial research websites that restrict access.  Even the free services rarely 
make it easy to create this kind of link. 

Thus, instead of doing the natural thing — drawing simple links from our briefs out to 
these materials — we often have to create PDF “printouts” of these pages and submit 
them to the court.  The result is clumsy and inconvenient.  Even so, it’s often easier than 
making the judge open a new browser window, log into a research service, and type in 
the citation themselves. 

Electronic briefing would look dramatically different if there were free, respected online 
repositories of information.  They don’t have to be the single most authoritative source 
of the information; courts just need to accept them as good enough for this purpose. 

Will a viable free option for primary case law emerge?  If projects such as Law.gov 
(http://resource.org/law.gov/) result in the creation of good repositories for federal 
cases and statutes, will courts start to accept hyperlinks to those repositories as suitable 
for electronic briefs?  Will innovative states decide to publish their own case law 
electronically and expressly encourage litigants to use hyperlinks to those official state 
websites?  
 

What the Future Might Hold 
 
Projecting the future is imperfect, but some patterns can be extrapolated from changes 
happening now.  One trend is that more and more raw materials are going online.  As 
courts obtain, for example, an electronic copy of the appellate record, it may be possible 
for briefs to hyperlink directly to that record rather than attaching fragments.  If briefs 
can hyperlink to reliable versions of the appellate record, the primary authorities, and 
other briefs, the task of making electronic briefs will be greatly simplified. 

Another route to simplicity would be better software for the readers of electronic briefs.  
Instead of using off-the-shelf PDF readers, legal readers may end up with specialized 
tools (perhaps developed by their legal research provider of choice) that can interpret 

http://resource.org/law.gov/�
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citations in a standard PDF and convert them to electronic hyperlinks.  With that tool at 
their disposal, courts would not need for counsel to expend the energy creating each of 
these links by hand, printing the cases to PDF, and assembling them onto a CD-ROM.  
Instead, this very mechanical task would be done (as it perhaps should) by the software. 

Another trend is the growing popularity of portable reading devices, such as Kindles, 
iPads, iPhones, and the like.  The iPad is already an excellent PDF viewing screen, if the 
9.7-inch screen size is comfortable for you.  In a few years, we may have even more 
natural form factors for reading briefs (whether a flexible screen e-ink or just an iPad or 
competing slate device large enough to be paper-sized). 

Other possible futures would be truly novel.  For example, rich electronic briefs could 
start to absorb more elements of oral argument.  A particularly adventurous court may 
offer counsel the chance to substitute a very short embedded video summarizing their 
petition in place of a written summary of argument.  This could offer a very different 
perspective than offered by a traditional summary, and it might allay public concern 
that appellate courts cannot hear a formal oral argument in every case. 

A different reshuffling of the relationship between briefs and oral argument would let 
courts pose their questions of counsel as comments on the published briefs in the case. 
During a certain part of its decision process, the Court might attach a series of questions 
to the briefs, some keyed to specific passages.  Counsel for each side would be able to 
respond electronically, with their comments folded into the brief structure for the 
Court’s reference.  This, again, would not replicate the Socratic discovery that can 
happen at oral argument.  But for the sort of case that might not likely have been chosen 
for argument, this could be a low-commitment way for the Court to gain the information 
it needs to make a just decision. 

Another preconception that might change is the idea that a brief is made up of discrete 
letter-sized pieces of paper rather than a continuous flow of text.   As briefs move toward 
being true electronic documents — when there may not be a paper version at all — the 
rationale for breaking them into page-sized chunks is less compelling.  Instead, briefs 
may look more like web pages or the various formats being developed for electronic 
books, such as the ePub standard (also by Adobe).  With an ePub brief, the reader can 
choose the font, can readily adjust the font size, and can reflow the text onto whatever 
screen size they are using at the time.  That flexibility would be a vast improvement over 
the technical rules we now follow about fonts, margins, font sizes, and spacing.  

A more radical change might move electronic briefs away from being neatly formatted, 
novella-length published works.  Instead, it might be possible to present an interactive 
brief that acts as a kind of decision tree.  A reader might work through the brief step by 
step, with each choice affecting what arguments and evidence is presented next.  The 
reader would, of course, be able to reveal the whole structure.  But by default the brief 
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would help the judge focus on just the parts most relevant based on how the judge was 
leaning on the threshold issues. 

 

How To (Safely) Innovate Now 
 
You have some latitude to be creative under the existing briefing rules.  If you can work 
within those constraints to produce something that tells your story in a particularly 
effective way, then no one will complain.  But if you find yourself unable to do what 
you’d like within the rules, then take a page from attorneys that have filed CD-ROMs  — 
file a motion asking for permission.  If you explain what you want to do and how it will 
assist the Court, you may find the clerk’s office very receptive to your request. 

By all means, don’t break the rules.  If you want to bend the rules to try something 
innovative, file a motion requesting permission to do so.  When the Court is impressed 
by what you have done, you may find that the rules themselves start to shift to permit 
future briefs to follow your lead. 

 

Let advocacy drive your electronic briefs, not just fascination with new toys—but 
don’t be afraid to innovate in the right case 

The first few times someone includes an image, a multimedia file, or an animation, the 
very fact will draw some attention from the Court.  But that advantage is rapidly lost.  If 
everyone includes multimedia without a particular reason, then briefs may start to feel 
like the Flash landing pages on restaurant websites.  

Readers already skip block quotes, often without realizing it.  A brief that included 
numerous clips of trial testimony as audio files, or that included diagrams on every 
page, is just begging to be skimmed instead of analyzed.  The mind can only absorb so 
much at a time, and the reader can only shift gears so many times. 

On the other hand, a well-placed diagram, photograph, or map could crystallize a key 
point for the Court.  Sometimes a picture is worth far more than 1000 words.  The right 
image can be the purest expression of the writing maxim “show, don’t tell.”  If nothing 
else, an image has an authenticity that it is hard to achieve just with a written 
description. 

Audio and video is more difficult.  When the U.S. Supreme Court decided a case that 
turned on the reasonableness of a police chase that happened to have been  captured by 
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the police dashboard camera video, it posted the full video online with its opinion.23

Most often, litigants have access to audio or video just of the litigation proceedings, 
which in the typical case are less likely to be useful to the Court.  They might even have 
the same soporific qualities as playing lengthy deposition excerpts at trial.  But your case 
may turn on how a key piece of testimony unfolded.  The context is what matters, and 
that’s an advocacy decision. 

  
But few cases turn on audio or video evidence about the material facts — or even have 
audio or video of the original facts. 

If you do choose to include multimedia files — items that cannot be represented in your 
printed, signed brief — you may be placing yourself at odds with the briefing rules.  One 
approach is to type out a hyperlink to the multimedia file rather than embedding it.  The 
video might be hosted in a permanent place on your firm website or on a commercial 
service.  And using a hyperlink (rather than embedding) avoids the potentially messy 
question of how to count a fifteen-minute video within a fifteen-page limit. 

Whatever your approach, you want to avoid letting multimedia files create an improper 
tone in your brief.  If you wouldn’t consider making an emotional jury argument to an 
appellate bench, you might not want to lead with an emotional photograph of the 
deceased plaintiff. 

Conclusion 
What you get out of electronic briefing will depend on what you put into it.  If you want 
minimal compliance with court rules, you will stay with the pack.  But with just a little 
effort beyond that minimum, you can make a significant difference in how helpful your 
briefing is to the court through bookmarks or simple hyperlinking.  Those counsel who 
invest the creative energy to push the boundaries even further might be helping to shape 
the electronic briefing rules — and the day-to-day realities of appellate practice — in the 
decades to come.   

                                                             
23 The case was Scott v. Harris, 550 U.S. 372 (2007).  The Supreme Court published the video at a page titled 
“Audio/Video Resources” (http://www.supremecourt.gov/media/media.aspx), which today only hosts two 
videos. 

http://www.supremecourt.gov/media/media.aspx�
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RESOURCES FOR CREATING BETTER ELECTRONIC BRIEFS 
 

Blogs and Websites: 
 
Adobe Acrobat for Legal Professionals : http://blogs.adobe.com/acrolaw/ 
 
PDF For Lawyers : http://www.pdfforlawyers.com/ 
 
Typography for Lawyers : http://www.typographyforlawyers.com/ 
 
Rocky Mountain Training blog : http://blog.rockymountaintraining.com/?tag=adobe-
acrobat 
 
The Supreme Court of Texas Blog : http://www.scotxblog.com/ 
 
Adobe :  www.adobe.com 
 

Books: 
 
How to Do Everything: Adobe Acrobat 9 by Doug Sahlin 
 
Adobe Acrobat 9 Classroom in a Book by Adobe Creative Team 
 
Adobe Acrobat 9 PDF Bible by Ted Padova 
 
Adobe Acrobat 9 How-Tos: 125 Essential Techniques by Donna L. Baker 
 

Companies Providing E-Brief Services:  
 
You should do your own research before hiring any of these companies! 
 
Animators at Law (Virginia): http://www.animators.com/ 
 
Best Evidence (Florida): http://www.bestevidence.com/ 
 
CAP Digisoft Solutions, Inc. (Texas) : http://www.capdigisoft.com/litigation-
suppot/ebrief-hyperlinking-service.php 
 
CDBrief, LLC (Washington): http://cdbrief.com/ 
 
Counsel Press (New York and elsewhere): http://www.counselpress.com/ 
 
eTrial/Brief-Lynx (Colorado) : http://www.etrialinc.com/brief-lynx.html 

http://blogs.adobe.com/acrolaw/�
http://www.pdfforlawyers.com/�
http://www.typographyforlawyers.com/�
http://blog.rockymountaintraining.com/?tag=adobe-acrobat�
http://blog.rockymountaintraining.com/?tag=adobe-acrobat�
http://www.scotxblog.com/�
http://www.adobe.com/�
http://www.amazon.com/How-Do-Everything-Adobe-Acrobat/dp/0071602704/ref=sr_1_1?ie=UTF8&s=books&qid=1274126571&sr=1-1�
http://www.amazon.com/Adobe-Acrobat-9-Classroom-Book/dp/0321552970/ref=sr_1_2?ie=UTF8&s=books&qid=1274126571&sr=1-2�
http://www.amazon.com/Adobe-Acrobat-9-PDF-Bible/dp/0470379197/ref=sr_1_4?ie=UTF8&s=books&qid=1274126571&sr=1-4�
http://www.amazon.com/Adobe-Acrobat-How-Tos-Essential-Techniques/dp/0321552946/ref=pd_bxgy_b_img_c�
http://www.animators.com/�
http://www.bestevidence.com/�
http://www.capdigisoft.com/litigation-suppot/ebrief-hyperlinking-service.php�
http://www.capdigisoft.com/litigation-suppot/ebrief-hyperlinking-service.php�
http://cdbrief.com/�
http://www.counselpress.com/�
http://www.etrialinc.com/brief-lynx.html�
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HyperBrief (Pennsylvania): http://hyperbrief.com/ 
 
National Data Support (California): http://nationaldatasupport.com/  (created a CD for 
an appeal to the Amarillo Court of Appeals, No. 07-00073-CV, Golden Spread Electric 
Cooperative, Inc. v. Denver City Energy Assocs., L.P. for Alexander Dubose & 
Townsend LLP) 
 
Paradocs (New York): http://www.paradocsonline.com/ 
 
Record Press (New York): http://www.recordpress.com/ 
 
TGL Media (Georgia) : http://www.tglmedia.com/Pages/whatwedo.html 
 
Theme Vision LLC (Indiana): www.themevision.com (produced the CD in Whirlpool v. 
Camacho) 
 

http://hyperbrief.com/�
http://nationaldatasupport.com/�
http://www.paradocsonline.com/�
http://www.recordpress.com/�
http://www.tglmedia.com/Pages/whatwedo.html�
http://www.themevision.com/�
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Introduction

Documents filed in CM/ECF must be filed in PDF (Portable Document Format) rather

than a word processing format such as WordPerfect or Word. This format is used

because, among other things, PDF documents retain the pagination, formatting, and

fonts of the original document; in other words, the document will look the same no

matter what type of computer is used to view it and what printer is used to print it.

Using and Creating PDF Documents

PDF is what is known as an “open standard” (i.e., its computer code is not proprietary).

Viewing or printing a PDF document is accomplished through any PDF reader program.

Adobe Acrobat Reader, a popular program, is downloadable free of charge from the

Internet. Creating, editing, or manipulating a PDF file, however, requires a PDF writer

program, which usually must be purchased through a commercial vendor. A well-known

one is Adobe Acrobat Writer.  Adobe Acrobat is available from www.adobe.com.

Documents converted directly from word processing are known as PDF text documents.

PDF documents can also be created by imaging (or scanning) paper documents. These

are sometimes known as PDF image documents. PDF text documents are word-

searchable; PDF image documents generally are not. PDF image documents are also

generally larger electronic files than PDF text documents.

Converting a WordPerfect File to PDF using Print Feature

Note: This option must not be used if the document contains hyperlinks.  To preserve

the hyperlinks, you must use the Publish to > PDF... option (described later in this

document).

1. Open the WordPerfect document to be converted to PDF.

2. Select File in the main menu bar.

3. From the File menu select Print.

http://www.adobe.com
http://www.adobe.com
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4. Select Adobe PDF (or Adobe PDF Writer or Adobe Distiller) as the printer name.
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5. Click Print.

Note: The file will not print to paper; instead the Save PDF File As dialog box

will appear.

6. In the Save PDF File As dialog box navigate to the appropriate location to save

the file.

7. Specify the name of the file in the File name field.Remember the file location and name as you will need to browse to find this filewhen you electronically file the document in CM/ECF.
8. Click Save.

Note: The file will be converted to PDF and the file name will contain the .pdf
extension. 
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Converting a WordPerfect File to PDF using Publish to PDF

(WordPerfect 9 or higher)

Note: In order to preserve hyperlinks, if any, this option must be used.

1. Open the WordPerfect document to be converted to PDF.

2. Select File in the main menu bar.

3. From the File menu select Publish To  >  PDF....

4. In the Publish To PDF dialog box choose a file location and file name. Remember the file location and name as you will need to browse to find this filewhen you electronically file the document in CM/ECF.



Converting Word Processing Documents to Portable Document Format (PDF)

24 Jun 2008 7

5. Click OK.

Note: The file will be converted to PDF and the file name will contain the .pdf
extension. 
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Converting a Word File to PDF using Word 2002/2003 Adobe PDF

Menu

1. Open the Word document to be converted to PDF.

2. If you are using a version of Word that has an Adobe PDF menu select it.

If not, skip to next section, Converting using Adobe Acrobat.

3. From the Adobe PDF menu select Convert to Adobe PDF.

4. If the Acrobat PDFMaker dialog box displays, select Yes to save the file in Wordfirst and then continue with the conversion.

If the Acrobat PDFMaker dialog box does not display, skip to step 7.

5. The document is saved in Word before it is converted to PDF.  In the Save As

window, navigate to the appropriate location to save the file.



Converting Word Processing Documents to Portable Document Format (PDF)

24 Jun 2008 9

6. Click Save.

7. The Save Adobe PDF File As window opens.  If necessary, navigate to the

appropriate location to save the file.
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8. Specify the name of the file in the File name field.Remember the file location and name as you will need to browse to find this filewhen you electronically file the document in CM/ECF.
9. Click Save.

Note: The file will be converted to PDF and the file name will contain the .pdf
extension.  The PDF file will be opened for previewing.
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Converting a Word File to PDF using Word 2007 Save As

Note: This option assumes that the Microsoft Save as PDF or XPS Add-In has been

installed on your computer.

1. Open the Word document to be converted to PDF.

2. Click the Microsoft Office Button  .

3. From the list, point (do not click) to Save As >, then click Adobe PDF.
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4. If the Acrobat PDFMaker dialog box displays, select Yes to save the file in Wordfirst and then continue with the conversion.

If the Acrobat PDFMaker dialog box does not display, skip to step 7.

5. The document is saved in Word before it is converted to PDF.  In the Save As

window, navigate to the appropriate location to save the file.
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6. Click Save.

7. The Save Adobe PDF File As window opens.  If necessary, navigate to the

appropriate location to save the file.
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8. Specify the name of the file in the File name field.Remember the file location and name as you will need to browse to find this filewhen you electronically file the document in CM/ECF.
9. Make sure the Fully functional PDF radio button is checked.  If you want to view

the PDF file after it has been converted, make sure the View result box is

checked.

10. Click Save.

Note: The file will be converted to PDF and the file name will contain the .pdf
extension.
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Converting a Word File to PDF using Word 2007 Acrobat Menu

1. Open the Word document to be converted to PDF.

2. Select Acrobat from the main menu bar.

3. From the Acrobat menu select the Create PDF icon.

4. If the Acrobat PDFMaker dialog box displays, select Yes to save the file in Wordfirst and then continue with the conversion.
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If the Acrobat PDFMaker dialog box does not display, skip to step 7.

5. The document is saved in Word before it is converted to PDF.  In the Save As

window, navigate to the appropriate location to save the file.



Converting Word Processing Documents to Portable Document Format (PDF)

24 Jun 2008 17

6. Click Save.

7. The Save Adobe PDF File As window opens.  If necessary, navigate to the

appropriate location to save the file.



Converting Word Processing Documents to Portable Document Format (PDF)

24 Jun 2008 18

8. Specify the name of the file in the File name field.Remember the file location and name as you will need to browse to find this filewhen you electronically file the document in CM/ECF.
9. Make sure the Fully functional PDF radio button is checked.  If you want to view

the PDF file after it has been converted, make sure the View result box is

checked.

10. Click Save.

Note: The file will be converted to PDF and the file name will contain the .pdf
extension.
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Converting a Word File to PDF using Print Feature

Note: This option must not be used if the document contains hyperlinks.  To preserve

the hyperlinks, you must use the one of the Word options described earlier in this

document.

1. Open the Word document to be converted to PDF.

2. Select File in the main menu bar.

3. From the File menu select Print.

4. Select Adobe PDF (or Adobe PDF Writer or Adobe Distiller) as the printer name.

5. Click OK.

Note: The file will not print to paper; instead the Save PDF File As dialog box

will appear.
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6. In the Save PDF File As dialog box navigate to the appropriate location to save

the file.

7. Specify the name of the file in the File name field.Remember the file location and name as you will need to browse to find this filewhen you electronically file the document in CM/ECF.
8. Click Save.

Note: The file will be converted to PDF and the file name will contain the .pdf
extension. 
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Converting a Word File to PDF using the Adobe Acrobat Application

1. Open the Adobe Acrobat application.

2. From the File menu select Create PDF > From File . . . 

3. Locate the Word document to be converted to PDF and click Open.
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Note: The file will be automatically converted to PDF and the file name will contain the.pdf extension.  The PDF file will be opened for previewing.
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Adobe Acrobat 9
Standard

Adobe Acrobat 9 Pro Adobe Acrobat 9 Pro
Extended

 

 Reader
9

Acrobat
9

Standard
Acrobat

9 Pro
Acrobat

9 Pro
Extended

View, print, and search PDF files, including PDF
Portfolios and PDF maps

Author, store, and share documents, and share your
screen, using Acrobat.com services

Experience richer content and greater interactivity
with native support for Adobe® Flash® technology

Create PDF documents from any application that
prints

Convert Microsoft Word, Excel, PowerPoint,
Publisher, and Access files to PDF with one-button
ease*

Capture web pages as rich, dynamic PDF files for
review and archiving

Archive e-mail or e-mail folders from Microsoft
Outlook or Lotus Notes*

Scan paper documents to PDF and automatically
recognize text with optical character recognition
(OCR)

Save PDF files as Microsoft Word documents,
retaining the layout, fonts, formatting, and tables, to
facilitate reuse of content

Help protect PDF documents with 256-bit encryption

Apply restrictions on printing, copying, and altering
PDF documents

Examine documents for hidden information and
delete as needed

Merge files from multiple applications into a single
PDF document

Assemble a wide range of content types in a polished,
organized PDF Portfolio

Review documents using familiar commenting tools
such as sticky notes, highlighting, lines, shapes, and
stamps

Manage shared document reviews that allow review
participants to see one another's comments

Enable real-time collaboration with synchronized
document views and chat

Digitally sign PDF documents

http://www.adobe.com/products/acrobatstd/
http://www.adobe.com/products/acrobatstd/
http://www.adobe.com/products/acrobatstd/
http://www.adobe.com/products/acrobatpro/
http://www.adobe.com/products/acrobatpro/
http://www.adobe.com/products/acrobatproextended/
http://www.adobe.com/products/acrobatproextended/
http://www.adobe.com/products/acrobatproextended/
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*
†

Certify PDF documents using digital IDs

Easily create fillable PDF forms from paper or existing
files using the Form Wizard

Distribute PDF forms to collect information and track
their status†

Enable users of Adobe Reader® (version 8 or later)
to fill in and save PDF forms locally

Convert documents to PDF/A for archiving with easy
search and retrieval

Validate documents for conformance to ISO
standards PDF/A, PDF/E, and PDF/X

Personalize a PDF Portfolio with customizable
templates for navigation and branding

Permanently delete sensitive information, including
specific text or illustrations, with redaction tools

Convert Autodesk® AutoCAD®, Microsoft Visio, and
Microsoft Project files to PDF with one-button ease,
preserving document layers in Visio and AutoCAD
and object data in Visio*

Enable users of Adobe Reader (version 8 or later) to
digitally sign PDF documents

Compare and highlight the differences between two
versions of a PDF document

Create dynamic XML forms with Adobe LiveCycle®
Designer ES (included)*

Preview, preflight, correct, and prepare PDF files for
high-end print production and digital publishing

Create and validate accessible PDF documents

Insert FLV or H.264 video for direct playback in
Adobe Acrobat® and Adobe Reader

Easily add audio, video, and quizzes to your
PowerPoint slides and create rich, interactive
presentations with Adobe Presenter (included)

Convert a variety of video formats to FLV for playback
in PDF

Embed video in Microsoft Word or PowerPoint and
convert to FLV in PDF

Convert 3D content to PDF for cross-platform sharing
and collaboration

Combine multiple CAD formats in one assembly and
save as PDF with Adobe 3D Reviewer (included)

Convert 2D and 3D designs from major CAD
applications to PDF for use by extended teams
without expensive CAD or viewer software

Create PDF maps by importing geospatial files that
retain metadata and coordinates

When enabled by Acrobat Pro or Acrobat Pro Extended.
Windows® only.
For ad hoc forms distribution and data collection for up to 500 people.
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Next steps
Buy Acrobat 9 ›

Free trial ›

http://www.adobe.com/go/buyacrobat_proext
http://www.adobe.com/go/tryacrobat_pro_win_landing



No. 08-0175 
 

In the Supreme Court of Texas 
 
 
 

WHIRLPOOL CORPORATION, 
 

          Petitioner, 
 

v. 
 

MARGARITA CAMACHO, ET AL., 
 
          Respondents. 
 
 

 
PETITIONER’S UNOPPOSED MOTION FOR LEAVE TO FILE A 

CORRESPONDING ELECTRONIC VERSION OF ITS  
PETITION FOR REVIEW ON COMPACT DISC 

 
 
 
TO THE HONORABLE THE SUPREME COURT OF TEXAS: 

Petitioner Whirlpool Corporation file this unopposed motion for leave to file a 

corresponding electronic version of its Petition for Review on compact disc. 

ARGUMENT 

On April 3, 2008, Whirlpool filed its Petition for Review, which is 15 pages in 

length and includes more than 50 citations to various cases, statutes, rules and secondary 

authorities, as well as 109 record cites.  Whirlpool now moves for leave to file a 

corresponding electronic version of its Petition on the enclosed CD-ROMs (compact 

disc-read only memory), which is identical in content to its paper brief. 



- 2 - 

The electronic version will assist the Court in reviewing the merits of the 

arguments.  It contains hypertext links to all materials cited in the brief, including cases, 

statutes, record citations, and secondary authority.  These hyperlinks will enable the 

Court instantly to access the cited authority and the referenced portions of the record 

without the hard copy of the 15-volume reporters’ record or the exhibits.  The reader of 

the electronic brief will be able, among other things, to conduct word searches of the 

entire document and move instantaneously from the table of contents to the 

corresponding section of the brief.  The reader can view the electronic brief with standard 

computer equipment, a CD-ROM reader and Adobe Acrobat/Reader software.  Attached 

to the enclosed CD-ROM is a document that explains how to open the e-brief and 

navigate within it.  The same document can be found when a reviewer opens the CD-

ROM folder (Microsoft Word document entitled “How To Use E-Petition.doc”) and, 

after one opens the e-brief itself, in the bookmark pane of the e-brief. 

Electronic briefs on CD-ROM are becoming more prevalent and have been filed in 

several cases before this Court and other Texas appellate courts, including: Neeley v. 

West Orange-Cove C.I.S.D., 176 S.W.3d 746 (Tex. 2005) (No. 04-1144); Northern 

County Mut. Ins. Co. v. Davalos, 140 S.W.3d 685 (Tex. 2004) (No. 02-1007); Tanox, Inc. 

v. Akin, Gump, Strauss, Hauer & Feld, L.L.P., 105 S.W.3d 244 (Tex. App.—Houston 

[14th Dist.] 2002) (No. 14-00-00765-CV); and Honda of Am. Mfg., Inc. v. Norman, 104 

S.W.3d 600 (Tex. App.—Houston [1st Dist.] 2003) (No. 01-00-01263-CV). 
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CONCLUSION AND PRAYER 

Whirlpool asks this Court to grant leave to file a corresponding electronic version 

of its Petition for Review on compact disc. 

Respectfully submitted, 

HAYNES AND BOONE, LLP 
 

  
Lynne Liberato 
State Bar No. 00000075 
Alene Ross Levy 
State Bar No. 12260550 
Mark Trachtenberg 
State Bar No. 24008169 
1221 McKinney, Suite 2100 
Houston, Texas  77010-2007 
Telephone: (713) 547-2000 
Telecopier: (713) 547-2600 
 
BARNES & THORNBURG, LLP 
Douglas K. Dieterly 
Peter J. Rusthoven 
600 1st Source Bank Center 
100 North Michigan Street 
South Bend, Indiana  47701-1632 
Telephone: (574) 233-1171 
Telecopier: (574) 237-1125 
 
ROYSTON, RAYZOR, VICKERY & 
WILLIAMS, LLP 
Keith N. Uhles 
State Bar No. 20371100 
Juan Noe Garza, Jr. 
State Bar No. 24036624 
55 Cove Circle 
Brownsville, Texas  78523-3509 
Telephone: (956) 542-4377 
Telecopier: (956) 542-4370 
 
ATTORNEYS FOR PETITONER, 
WHIRLPOOL CORPORATION 
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CERTIFICATE OF CONFERENCE 
 

I hereby certify that I have conferred with counsel for Respondents, Mr. Kevin 
Dubose, and that he does not oppose the relief requested in this motion. 
 

______________________________________ 
Alene Levy 

 
 
 

CERTIFICATE OF SERVICE 
 

In accordance with the Texas Rules of Appellate Procedure, I hereby certify that a 
true and correct copy of the foregoing instrument has been sent to the following counsel 
of record on this 25th day of April, 2008: 
 
Attorneys for Respondents: 
 

Kevin Dubose      Via Certified Mail 
ALEXANDER, DUBOSE, JONES 
      & TOWNSEND, LLP 
1844 Harvard Street 
Houston, Texas  77008 
 
Joe Escobedo, Jr.      Via Certified Mail 
Luis Cardenas 
ESCOBEDO, TIPPIT  & CARDENAS L.L.P. 
3900 N. 10th Street, Suite 950 
McAllen, Texas  78501 
 
Alberto A. Munoz, II     Via Certified Mail 
LAW OFFICE OF ALBERTO A. MUNOZ, II 
Post Office Box 9600 
McAllen, Texas  78502-9600 
 
Aaron E. Vela      Via Certified Mail 
THE BUZBEE LAW FIRM 
200 East Cano Street 
Edinburg, Texas  78539 

 
 

  
Lynne Liberato 

H-723014.1 
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